Visit the following websites to learn more about this book:

[Logo for SDC Publications] [amazon.com] [Barnes & Noble] [Google Books]
Lesson 4
Revit Materials:

Organizing and documenting materials is an important task for the interior design professional. This involves developing material collections/systems for spaces, understanding products being specified (and material options available for them), building code constraints (e.g., flame spread ratings), cost, availability and much more. Autodesk® Revit® Architecture allows much of this to be managed within the BIM database. This chapter will cover the basics, and be applied to our Law Office project.

Exercise 4-1:
Introduction to Using Materials in Revit

In Revit, a Material is more than just something you can touch or hold in your hand. It is a “container” which helps to keep track of the following:

- **Identity**
  - Descriptive Information
  - Product Information
  - Annotation Information

- **Graphics** asset
  - Shading
  - Surface Pattern and color
  - Cut Pattern and color

- **Appearance** asset
  - Photo-realistic render appearance
    - Texture
    - Reflectivity
    - Transparency
    - Self-Illumination
    - Etc.

- **Physical** asset
  - Structural engineering data
    - Concrete
    - Steel
    - Aluminum
    - Wood

- **Thermal** asset
  - Energy modeling data
    - Thermal Conductivity
    - Specific Heat
    - Etc.
In Revit, a single named item called a *Material* holds all of this information. We will discuss each of the items listed above in more detail, but first let’s talk about how a *Material* is used.

*FYI:* Anytime a Revit term or tool is mentioned in this book it is title-case and italicized. This helps the reader to distinguish a software term, such as *Material*, from a design industry term such as *material*.

There are three primary ways in which a *Material* is used, or applied, in a model:

- *By Category*
- *By Element*
- *By Face*

Each of these will be discussed in detail in a moment, but first notice the three walls below. The left wall segment has a light color and 4” tile pattern applied *By Category*. The middle wall has a light color with a brick pattern *By Element*. The last wall has a solid darker color painted on a single face (*By Face*).

**By Category**

When a 3D element does not have a specific *Material* applied, the project-wide *Object Style* is used, accessed by this dialog: **Manage ➔ Settings ➔ Object Styles**.

In Figure 4-1.1, notice the various categories listed: Furniture, Casework, Doors, etc. These are hard-wired categories Revit uses to organize elements, control visibility, and in the case of this discussion, controls how elements look. Each category may be assigned a default *Material*. When a 3D element has its *Material* parameter set to *<By Category>*`, the *Object Style Material* is used.

It is often not too important to set the *Material* here because each 3D element often has a *Material* assigned to it, which takes precedent over *Object Styles*. For example, the pedestal sink shown to the right has a “Sink – Porcelain” and a “Sink – Faucet” material assigned directly to...
the various 3D elements contained within the Family (i.e., component). Therefore the Plumbing Fixture Material in Object Styles is ignored. It might be best to set the Object Styles materials to an unusual color to draw attention to any element which does not have a specific Material selected in your project.

By Element

The most common way a Material is applied to something is By Element. This is true for System Families and Loadable Families. Note the following:

- **System Families** (walls, ceilings, floors, etc.):
  These elements cannot exist outside of a project, therefore the Material adjustment option is built into the dialog box which is used to develop the assembly, the Edit Assembly dialog box, an example is shown on the next page.

- **Loadable Families** (furniture, casework, specialty equipment, doors, etc.):
  These are Families which are developed in the Family Editor environment. Every 3D element in a Family has a Material parameter. When the item is first created, the Material parameter is set to By Category. This parameter is usually changed in one of two ways:
○ **Picking a Material**
  When a *Material* is selected directly, it is basically hard-wired and cannot be changed in the project.

○ **Mapping to a Material Parameter**
  When a *Material Parameter* is employed, the *Material* can easily be changed in the project; this can be an *Instance* or *Type* parameter.

We will expand on this to help clarify the concept. Some of this information might be difficult to understand when one first begins using Revit. However, it is best to quickly read through this information now and then plan on referring back here to help fill in the gaps as needed.

The *Edit Assembly* dialog, shown to the left (Figure 4-1.2), highlights how the *Material* selection is built into the workflow for developing an assembly (i.e., *System Family*), a wall in this case. This is all done directly in the project environment.

The *Edit Assembly* dialog is similar for the other *System Families* such as Floor, Roof and Ceiling.

Next we will look at a simple chair family (Figure 4-1.3) which comes with the Revit Architecture software. We will see how three *Materials* have been utilized in this *Family*, but only two are selectable in the project.

The *Family* is: **Chair-Tablet Arm.rfa**, and can be found here: C:\ProgramData\Autodesk\RAC 2013\ Libraries\US Imperial\Furniture\Seating

If we load this chair into a project, we can observe a few things about it. You may try this in Revit while reading, but is not required. First, if the chair is selected, you can click the *Edit Type* button, on the *Properties Palette*, to view the *Type Properties*.
Notice the two Material Parameters: Seat/Back Material and Tablet Material (Figure 4-1.4). These can both be changed to another Material by clicking in the Value field and selecting the small button that appears to the right. This opens the Materials dialog, from which another Material can be selected or created.

\textit{FYI: By changing a Type Parameter, every chair of this type within the project will be instantly updated.}

So, unlike the seat/back rest and tablet surface, the chair legs and back support Materials are not directly changeable in the project. There is a specific Material in use, and it appears in the Material dialog, but the Material used for the legs/back rest cannot be changed in the project – only in the Family Editor.

**By Face**

The third way in which a Material is typically applied is by using the \textit{Paint} tool, which adds a Material to a single face. This feature has some limitations in the context of a pure BIM project.

The \textit{Paint} tool is used on System Families, such as Walls, Floors, Ceilings, etc. The following description of how the tool is used is meant to be superficial and does not need to be done in a Revit file at this time. The Paint tool is selected on the Modify tab, a Material is selected from a dialog that appears, and then individual faces are selected.

The image to the right (Figure 4-1.5), shows a wall with three of the six faces visible from this vantage point. Thus, using the \textit{Paint} tool you can only change the surface Material of these three faces. You would need to change the view of the wall to override the other faces.

When a surface is painted, Revit paints the entire face, not just the portion visible in the current view.
view. For example, an interior elevation might be of a wall common to a corridor, or hallway. Revit will paint the entire side of the corridor wall, not just the portion visible in the specific room you are in (Figure 4-1.6).

Revit does provide a way to constrain the area, or extents, of a Material to be painted on a face. This is accomplished using the **Split Face** tool, found adjacent to the **Paint** tool on the **Modify** tab. When the **Split Face** tool is selected, you select a surface and then Revit enters sketch mode; here you draw lines, which are constrained to the plane of the surface. These lines must define an enclosed area.
The image below (Figure 4-1.7) shows the *Split Face* tool used to define the entire wall in room number one, between the demising walls and up to the ceiling. The *Split Face* was also used to define the wainscot finish in room number 2. Note that the same corridor wall has two separately defined areas using the *Split Face* tool.

![Figure 4-1.7](image1.png)

*FIGURE 4-1.7*
Split Face tool used to constrain painted areas

In the image below, the *Split Face* and *Paint* tools were used to define an area for the accent band and wall base (Figure 4-1.8). Everything in this image is created by the reader, which consists of: Shaw flooring, Toto plumbing fixtures, and Dal Tile.

![Figure 4-1.8](image2.png)

*FIGURE 4-1.8* Toilet room created by reader later in this textbook
This section will take a closer look at the Revit Material itself. Here you will gain a better understanding of what information, both textual and graphical, is contained within any given Material.

**Exercise 4-2:**
**A Detailed Look at Revit Materials**

As mentioned in the previous section, a Material in Revit is a “container” which holds information about the various materials used in the project. Some of the information contained in a Material is used prior to construction for visualization and documentation and some can be used during Construction Administration and after for Facilities Management.

To explore the Materials in a project, most of which come from the project template, click the Materials button on the Manage tab.

You will see the Materials dialogs shown below (Figure 4-2.1).

**FIGURE 4-2.1** Materials dialog
FYI #1: Clicking the drop-down list, pointed out with the #1 arrow, in Figure 4-2.1 allows you to switch the material list to just be text (as shown) rather than a preview (see also Figure 4-2.2). This adjustment allows you to see more items in the limited space.

FYI #2: If the Material Editor dialog is not open you need to click the icon pointed out with the #2 arrow. Just click the OK button when finished so both dialog boxes open together and never click the Done button.

FYI #3: You can also drag the bottom edge of the dialogs to make them taller, thus showing more information.

We will now take a close look at the various aspects of the Material dialogs. It is a good idea to review this information closely now and refer back when needed. Having a good understanding of this fundamental feature will benefit the interior designer substantially. It is not necessary to follow along yet; if you do, it is recommended you do not save. The next exercise will have several steps which will be done in a project to apply what is presented in this section.

In the Materials dialogs (Figure 4-2.1), notice the list of Materials on the left side of the screen.

This list can be sorted in two ways:
- Material usage state
- Search words

Selecting by the drop-down list (#1, Figure 4-2.2), allows you to narrow the list down to just Materials used in the project, or not used. The default is Show All, so both used and not used appear in the list.
**Word search** allows you to enter a term by which the *Materials* list is filtered. The image below (Figure 4-2.3) filters the *Materials* list down to any *Material* or *Category* containing the word “wood”

A combination of the two can be used to further filter the list down, and quickly get to the information you need. Notice in Figure 4-2.4, the list is sorted by the word “laminate” and for unused materials in the current project.

To wrap up the discussion on the list of *Materials*, when you right-click on a Material name, you can **Duplicate**, **Rename** and **Delete** materials as seen in Figure 4-2.5. Also, at the bottom of the *Material Editor* dialog, a small icon allows one to create a new *Material* in addition to duplicating an existing one.
Now that you understand the mechanics of the Materials list itself, you will take a look at the information contained within each Material. This information is viewed in the Material Editor dialog, and the information seen is based on which Material is selected in the Material Browser. If the Material Editor is not visible, click the small icon in the lower right corner of the Material Browser.

• Identity

With the first Material selected in the Material Browser list on the left, Acoustic Ceiling Tile 24" x 24", notice the Identity options available in (Figure 4-2.6).

○ Descriptive Information
This is an area to expound upon the material name to help the design team understand what this material is, or is used for.

○ Product Information
Who makes this material, for how much and where can I find more information? You can enter this information here. For example, you might have a Material which represents a specific fabric, which is applied to a Haworth or Steelcase furniture Family. The parameters for the furniture Family will list the furniture manufacturer; Haworth or Steelcase in this example. But the Material applied within the furniture Family is tracking the fabric information.

○ Revit Annotation Information
It is possible to add Smart text with optional arrows, which is called a Tag, in a drawing view to report information about a specific Material. If the information changes, the Tag will update automatically. You will learn more about keynoting later in this book.
• **Graphics Asset**

The information found in the *Graphics* panel primarily relates to how the various *Materials* appear on screen and how they print on paper, or in a PDF. This closely relates to the development of the *Construction Document (CD)* deliverables. The image shown below still relates to the Acoustic Ceiling Tile (ACT) *Material*. (Figure 4-2.7)

- **Shading**
  This is the solid color used on-screen when the *Visual Style* is set to *Shaded* or *Consistent Colors*.

  The *Transparency* setting is used to make certain objects see-through. This applies to all of the *Visual Styles*. The most common application of this feature is on glass.

  The color set for *Shading* is not used in any way for photo-realistic renderings. This color can be derived from the information specified for renderings by checking the *Use Render Appearance* option.

- **Surface Pattern (and Color)**
  When a *Surface Pattern* is selected, Revit will display this pattern anytime an object’s surface is visible in a view. For example, if the ACT *Material* is applied to a ceiling element, the 24” x 24” pattern will be applied to it in the *Ceiling Plan View* and any 3D views. See the next page for an example.

- **Cut Pattern (and Color)**
  When a *Cut Pattern* is selected, Revit will display this pattern within the boundary of an object, if that object is being cut within the view. Objects will typically be cut in section and detail views. A *Floor Plan* has a horizontal cut plane at about 3’-6” above the level. So most elements which pass through this cut plane have the *Cut Pattern* shown. The most common example would be walls. See the next page for an example.

  ![Figure 4-2.7 Material dialog; Graphics asset](image)
Overview of how Surface and Cut patterns are used in a Revit model:

The three views shown on this page are used to illustrate how surface and cut patterns, as defined within a Material, are applied to model elements. See the next page for more detailed notes on these images.
FLOOR PLAN EXAMPLE:
Looking at the previous page, the floor plan example shows a *Cut Pattern* within the walls and a *Surface Pattern* on the floor. The 8’-0” tall walls extend up through the 3’-6” cut plane. Therefore, for the *Material* applied to the wall, the *Cut Pattern* specified is shown. The floor exists entirely below the 3’-6” cut plane, so we are seeing its surface; therefore the material’s *Surface Pattern* is applied. Refer back to Exercise 1-1 (Views discussion starting on pg. 1-8) for an overview on how the *Cut Plane* interacts with the model.

ELEVATION/SECTION EXAMPLE:
In this example, the floor and the wall on the right are in section (see the section line in Figure 4-2.8). The wall with the window is not being cut, rather is seen in elevation, or projection. Note, the two walls are the same type (i.e. 8” Masonry), and use the same *Material*. Therefore, the wall’s *Material: Cut Pattern* is shown in the portion of wall in section and its *Material: Surface Pattern* is shown for the wall in elevation/projection. The floor is made up of multiple layers, and the larger part which represents the structure does not have a *Cut Pattern* selected in the *Material* being used, it is set to “<none>”. Thus, the floor does not have a *Fill Pattern* shown when in section. Final note, even though the glass has a transparent material, it does not show up transparent in elevation and section views; only 3D views as you will see in the next example. This is because we typically don’t want extra “clutter” showing up within the windows and doors. As you can see, no part of the tree appears within the window.

3D VIEW EXAMPLE:
In this view everything is in elevation/projection, so the surface pattern is used for the applied *Material*. Note: the walls and floor appear to be cut, but that is just the way they were modeled for this example. In 3D views, the transparency is applied to the element so the tree is visible through the window.

Here are a few more points about patterns used in Materials:

- **Surface and Cut Patterns Optional:**
  Keep in mind that *Surface* and *Cut patterns* are optional. In large commercial projects it is often undesirable to see a floor pattern as the drawing gets too cluttered with notes, dimensions and tags. In building sections the ceiling is not really thick enough for a pattern to show, so the model is more efficient when these extra lines are not all being generated in a given view.

- **Pattern Scale:**
  This topic will be covered in more detail later, but is worth pointing out at this juncture. There are two types of *Fill Patterns* in Revit: *Model* and *Drafting*. *Model Patterns* typically represent actual materials such as ceiling tile, concrete block (CMU) and brick to name a few. *Drafting Patterns* symbolically represent a material, thus the density of the pattern changes with the *View Scale* to help improve clarity (in a
similar way that text and dimensions adjust with the view’s scale). The example below (Figure 4-2.9) shows the same 12” concrete wall in section. Notice how the density of the Drafting Pattern changes when the View Scale is adjusted.

FYI: Notice that the line weights also change when the View Scale changes. Larger scales have lighter line weights because they are view closer.

![Figure 4-2.9](image)

**Figure 4-2.9** Drafting patterns automatically adjust size with view scale

- **Appearance Asset**
  The settings in this panel only come into play in one of two ways:
  1) *Visual Style* is set to *Realistic* or *Ray Trace* for the current view
  2) When doing a *Rendering*

  Otherwise, the way an element appears in Revit is controlled by the settings on the *Graphics* asset, unless otherwise overridden.

  - **Photo-realistic render appearance**
    Different types of materials have unique options. For example, paint has an *Application* setting where you can select *Roller*, *Brush*, or *Spray*; compare Figures 4-2.10 and Figure 4-2.11.

  ![Figure 4-2.10](image)

  **Figure 4-2.10** Material Editor: Appearance panel
When creating materials it is important to use the correct asset-type. Notice in the image to the right (Figure 4-2.11) that is specifically indicates “Wall Paint” and the previous image for the ACT indicated “Generic”. The use of Generic should be used as little as possible. When Revit knows what the material is, e.g. it is not Generic, the renderings are more realistic.

With many Appearance Assets you can specify a raster image file (i.e., texture) to be used to fill or cover a surface during a rendering. This can be an actual photo of a material or a simulation. The main thing is the image needs to be tileable. This means when the image is copied over and up, to fill a surface, the edges of the image will not be apparent. See the two examples below (Figures 4-2.12 and 4-2.13).
Clicking on the image of the material, when one is used by a given appearance asset, it opens another dialog where you can adjust how the image is applied to the surface and align it with the Fill Pattern (Figure 4-2.14). In the Texture Editor, if a setting does not have a check in the box, it is not considered in the appearance. Many of the settings are self-explanatory and can be quickly tested by adjusting the values to see how it impacts the preview and rendering.

It is important to pay attention to the dimensions listed. Notice the 16'-0" by 16'-0" dimensions in the example. Dividing this dimension by the number of tiles visible in the image tells use each tile will be 2'-0"; which is correct. However, if we download an image file from a manufacturer’s website we will want to make sure to verify the number of tiles has not changed. If it did, we would have to adjust the scale values.

- **Physical Asset**
The Physical panel is primarily used by the structural engineer to manage the structural properties for concrete, steel, aluminum and wood. This information can be used in structural analysis programs. When this information is not applicable, the Asset can be deleted from the Material.

The example shown to the left is for the Aluminum Material. The Mechanical and Strength section can be expanded to reveal additional information. (Figure 4-2.15) Notice, when your cursor hovers over the asset title, Replace and Delete icons appear.
• Thermal Asset

The Thermal aspect of a Material is used in energy modeling calculations (Figure 4-2.16). The basics are computed directly within Revit, such as the R-Value and Thermal Mass of a wall or floor (Figure 4-2.17). More advanced calculations can be derived in external applications.

A related feature is that assemblies (i.e. system families) can now calculate the total R-Value and Thermal Mass as shown in Figure 4-2.17.

FYI: Deleting all the Thermal assets from your Materials will cause these fields to be blank.

It should be pointed out that the values shown are provided by Revit for many standard real-world materials. The average software user is not expected to know this information. However, once a Physical or Thermal asset is loaded into a project, a person knowledgeable in the area of structural design or energy modeling can make adjustments to these values if needed. An example might be a special type of rigid insulation can be used which is not widely used. Therefore, the energy modeling expert can adjust the values for this known condition.
Adding or Replacing Assets
All of the Assets, except Graphics, can be replaced with another option from the provided library. Additionally, the Physical and Thermal assets can be deleted.

If the asset already exists, but you want to change it, click the “Replace” icon shown in Figure 4-2.18. This will open the Asset Browser, from which you can choose a different Asset (Figure 4-2.18). The Asset’s properties are hard-wired in the libraries and not directly editable until loaded into a project.

Clicking the icon pointed out in Figure 4-2.19 (item # 2) will push the Asset into the currently selected Material.

If your Material does not have a Physical or Thermal asset, in the Material Editor you use the Add Asset drop-down option shown in Figure 4-2.20. This too will open the Asset Browser.

An asset can be associated with multiple Materials. For example, several materials may be based on the same Physical asset such as “Pine – Southern”. Keep in mind, however, if the asset is adjusted, this will affect all the materials which use it. If a different version were needed, you would have to duplicate the asset before making changes. You will do this later in this chapter.
Materials Library
If the Material you want is not available in your project, in the In Document area of the Material Browser, you can either create one or load it from the AEC Materials library. If the Material you want exists in the library this is much faster than creating your own as it has all the assets, including Physical and Thermal, preloaded.

The search box at the top of the Material Browser actually searches both the materials in your project and the library (Figure 4-2.21). Notice there are six materials within the project which contain the word tile in the name AND there are several results, within several categories, below in the library.

It is possible to create a custom library here. The library can be stored on a server so multiple users may access it. Use the icon in the lower left to get started with a custom library.

To load a Material into your project from the library, simply double click on it.

Custom Information
The Custom Parameters button, at the bottom of the Material Editor, gives you access to a list of Material-based parameters in the project. These are user create parameters used to track pretty much anything you want. One example might be the source distance to better manage which products are locally sourced for LEED accreditation. Clicking this button opens a separate dialog to view the custom parameters (Figure 4-2.22). It is too bad one cannot initiate the creation of a Material parameter from this dialog.

Conclusion
This has been a fairly thorough overview of Materials in Revit. In the next exercise you will apply some of these concepts to help reinforce the ideas recently put forth.
Exercise 4-3:
Revit Materials Concepts Applied – Part 1

This section will apply many of the concepts covered thus far. You will open the architectural starter project provided on the DVD and work in a copy of it. Be sure to backup this file as it is the file you will work on throughout this book.

Before we open Revit, we will cover a few technical points related to materials. Many materials are noted in drawings using abbreviations. The abbreviations used may vary slightly from firm to firm. A few standards exist and are generally good to follow. However, as long as the abbreviations used are defined within the Contract Documents, drawings or project manual, it is “legal” to use whatever you want. Below is an example of an Interior Design group’s abbreviations list (Figure 4-3.1). Keep in mind that other disciplines might have their own abbreviations list, which would be located in another section of the project. Using duplicate abbreviations between disciplines should be avoided. For example, CC means Cubical Curtain in the list below, so the Civil design group should not use CC to mean Concrete Curb on their drawings if at all possible.

### ABBREVIATIONS

<table>
<thead>
<tr>
<th>ACP</th>
<th>ACOUSTIC CEILING PANEL</th>
<th>EQ</th>
<th>EQUIL</th>
<th>LOW</th>
<th>LINEAR WOOD CEILING</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACT</td>
<td>ACOUSTIC CEILING TILE</td>
<td>EXP</td>
<td>EXPANSION/EXPOSED</td>
<td>MET</td>
<td>METAL</td>
</tr>
<tr>
<td>ADJ</td>
<td>ADJACENT</td>
<td>EX</td>
<td>EXISTING</td>
<td>MTL</td>
<td>METAL</td>
</tr>
<tr>
<td>AF</td>
<td>ATHLETIC FLOORING</td>
<td>EXIST</td>
<td>EXISTING</td>
<td>MISC</td>
<td>MISCELLANEOUS</td>
</tr>
<tr>
<td>AFF</td>
<td>ABOVE FINISHED FLOOR</td>
<td>FAP</td>
<td>FLUID APPLIED FLOORING</td>
<td>NA</td>
<td>NOT APPLICABLE</td>
</tr>
<tr>
<td>ALUM</td>
<td>ALUMINUM</td>
<td>FB</td>
<td>FABRIC</td>
<td>NIC</td>
<td>NOT IN CONTRACT</td>
</tr>
<tr>
<td>AP</td>
<td>ACOUSTIC PANEL</td>
<td>FIN</td>
<td>FINISH</td>
<td>PERF</td>
<td>PERFORATED</td>
</tr>
<tr>
<td>AVT</td>
<td>ACOUSTIC WALL TREATMENT</td>
<td>FPR</td>
<td>FIBERGLASS REINFORCED PANEL</td>
<td>PHP</td>
<td>PHENOLIC PANEL</td>
</tr>
<tr>
<td>BMU</td>
<td>BURNISHED MASONRY UNIT</td>
<td>GB</td>
<td>GRAB BAR</td>
<td>PLAS</td>
<td>PLASTER</td>
</tr>
<tr>
<td>BR</td>
<td>BUMPER RAIL</td>
<td>GL</td>
<td>GLASS</td>
<td>PLAM</td>
<td>PLASTIC LAMINATE</td>
</tr>
<tr>
<td>CAB</td>
<td>CABINET</td>
<td>GRT</td>
<td>GROUT</td>
<td>PP</td>
<td>POLYMER PANEL</td>
</tr>
<tr>
<td>CC</td>
<td>CLICAL CURTAIN</td>
<td>GT</td>
<td>GLASS TILE</td>
<td>PFIN</td>
<td>PREFINISHED</td>
</tr>
<tr>
<td>CJ</td>
<td>CONTROL JOINT</td>
<td>GYP</td>
<td>GYPSUM WALL BOARD</td>
<td>PR</td>
<td>PORCELAIN TILE</td>
</tr>
<tr>
<td>CT</td>
<td>CERAMIC TILE</td>
<td>GBW</td>
<td>GYPSUM WALL BOARD</td>
<td>PT</td>
<td>PAINT</td>
</tr>
<tr>
<td>CG</td>
<td>CORKER GUARD</td>
<td>HM</td>
<td>HOLLOW METAL</td>
<td>QT</td>
<td>QUARRY TILE</td>
</tr>
<tr>
<td>CONC</td>
<td>CONCRETE</td>
<td>HPC</td>
<td>HIGH PERFORMANCE COATING</td>
<td>QS</td>
<td>QUARTZ SURFACING</td>
</tr>
<tr>
<td>OPL</td>
<td>OUGHT</td>
<td>HPL</td>
<td>HIGH PRESSURE LAMINATE</td>
<td>RB</td>
<td>RESILIENT BASE</td>
</tr>
<tr>
<td>CR</td>
<td>CRASH RAIL</td>
<td>HR</td>
<td>HAND RAIL</td>
<td>RES</td>
<td>EPOXY RESIN</td>
</tr>
<tr>
<td>EJ</td>
<td>EXPANSION JOINT</td>
<td>HT</td>
<td>HEIGHT</td>
<td>RESC</td>
<td>RESILIENT FLOORING</td>
</tr>
<tr>
<td>EM</td>
<td>ENTRY MAT</td>
<td>LF</td>
<td>LINEAR FEET (FOOT)</td>
<td>SSOC</td>
<td>SEALED CONCRETE</td>
</tr>
<tr>
<td>EP</td>
<td>EPOXY</td>
<td>LN</td>
<td>LINOLEUM</td>
<td>SFT</td>
<td>SPECIALTY CEILING TILE</td>
</tr>
</tbody>
</table>

**Figure 4-3.1** Abbreviation list for interior design drawings

Generally speaking, generic terms should be used rather than trademarked manufacturer terms. For example, drawings noting the construction of an interior wall or soffit should say “GYPSUM BOARD” rather than something manufacturer-specific such as DRYWALL or SHEETROCK. This helps to avoid confusion during bidding and construction, especially on publicly funded projects which require competitive bidding. That is, two or more manufacturers must be specified, not just the designer’s favorite choice, for better or worse.

Having said that, sometimes the drawings list a specific product to be used as the benchmark for other manufacturers, or approved equals. Next you will be creating a number of Materials in Revit and entering some of the descriptive data about them.
Creating Materials

Open Revit Architecture.

You will select a starter file from the DVD that came with this textbook.

1. Select Open from the Quick Access Toolbar.

2. Browse to the Law Office.rvt model located on the DVD.

3. Select Manage tab  Settings panel  Materials.

Next you will create a duplicate of the carper Material. The easiest thing to do is first select a similar Material to the one you wish to create. In this case you are about to create a new Material to represent carpet, so you will be instructed to select an existing carpet material, existing in that it is already in the project, not in the sense of it already installed in the actual building.

4. In the Materials list, select Carpet (1) as shown in Figure 4-3.2A.

5. Right-click Carpet (1) and then click the Duplicate in the pop-up menu (Figure 4-2).

![Figure 4-3.2 Duplicating a material](image)
A new Material is created with a name similar to the original; Carpet (2). You will rename it.

6. Right-click on *Carpet (2)*, select **Rename**, and enter the name **CPT1**.

7. Switch to the **Identity** panel, in the Material Editor, for the new **Material – CPT1**; information shown will be entered in Step 13.

Next you will go online and find the information needed to complete the **Material** definition for CPT1. Finding information such as this at the beginning of a project is not usually necessary. This could be information already saved in your Revit template file, if this is a specific product you regularly use in your designs.

Please refer to the following list for the next several steps. This list is similar to what one might find in a set of construction documents.

09 6800 - TILE CARPETING

**CPT1 CARPET TILE 1**
- MFG: INTERFACE FLOR
- GROUP: THE POND COLLECTION
- STYLE: COLOGNE (12420)
- SIZE: 20"X20" NOMINAL (50 CM X 50 CM)
- COLOR: 6363 PEAT
- LOC: PUBLIC SPACES

**CPT2 CARPET TILE 2**
- MFG: INTERFACE FLOR
- GROUP: THE POND COLLECTION
- STYLE: WEIMER (12421)
- SIZE: 20"X20" NOMINAL (50 CM X 50 CM)
- COLOR: 6688 PEAT
- LOC: OPEN OFFICE, PUBLIC ACCENT

**CPT3 CARPET TILE 3**
- MFG: INTERFACE FLOR
- GROUP: THE POND COLLECTION
- STYLE: WEIMER (12421)
- SIZE: 20"X20" NOMINAL (50 CM X 50 CM)
- COLOR: 6968 ACORN
- LOC: ACCENT

First you will focus on the carpet material CPT1, which is manufactured by Interface Flor.

8. Open your web browser; browse to [http://www.interfaceflor.ca](http://www.interfaceflor.ca)

9. Select your region, e.g. *Americas\United States*, and then hover over the **Products** link, and then click **Product Search** (Figure 4-3.4).

**FYI:** The website design may change; follow along as best you can.
10. In the “Find by Product Name” section select **Cologne** from the list (Figure 4-3.5).

11. Click **Find Tile**.

12. Find color **6363 (Peat)** as shown in Figure 4-3.6; click **View Details**.

You now have access to all the information you need to define the Revit **Material** (Figure 4-3.7).

13. In Revit, enter the information shown in Figure 4-3.3.
   a. Copy/Paste the website address for the current product page to the URL field in Revit.
   b. Click the small button to the right of the **Keynote** field and then select **09 68 00 Carpet** as shown in Figure 4-3.8).

**NOTE:** You will learn more about keynoting later in the book.

As you can see on the webpage for this product, there is much more information available than Revit has built-in parameters for. That is why you are adding a web address (URL) to this information.
Next you will switch to the Appearance panel and make some adjustments, and then come back to the Graphics panel.

Notice, on the Appearance panel (Figure 4-3.9), that a PNG raster image is assigned to this material. You will download an image from the carpet manufacturer’s website and then edit your Material to use this new image. Keep in mind that anyone who might work on the project needs access to the image file location. So, in an office environment, you would not want to save this file to your local hard drive.

*TIP:* You can set the path to the raster images via Application Menu ➔ Options ➔ Rendering. Do this on each user’s computer.

*Figure 4-3.7* InterfaceFLOR website - specific product page

*Figure 4-3.8* Keynotes selection dialog
14. Switch back to the **InterfaceFlor** website.

15. Under the preview image, click **More Actions ➔ Save Image** (Figure 4-3.7).

16. Click **Save**.

Next you will specify a name and location for the raster image you are about to save. Pay close attention to the drive and folders in which the file is saved. You will need to point Revit to this file location in a moment.

17. Browse to a location on your computer to save this image; name the image **InterfaceFlor_Carpet__124206363.jpg**.

You now have an image file which represents the specified carpet style available on your computer or network. You will assign this image to the **Appearance** asset. But first you will duplicate the **Appearance** asset because the one named “Red” (Figure 4-3.2) is not applicable.

18. Back in Revit, on the **Appearance** panel, right click on the **Appearance** asset title as shown in Figure 4-3.9.

19. Select **Duplicate**.

20. Expand the **Information** area and change the **Name** to **CPT1**.

   a. You should also edit the **Description** as well.

   ![FIGURE 4-3.9 Duplicating an appearance asset](image)

You now have a new **Appearance** asset in your project named **CPT1**. This can be changed without affecting any other material.

21. In the **Material Browser**, click on the file name link pointed out in Figure 4-3.10.

22. Browse to the image file saved in Step 17 above, select it and click **Open**.
Now, when using the Realistic or Ray Trace display styles OR doing a rendering, this image will be mapped to any surface which has been assigned the CPT1 Material. However, right now the carpet tiles will not be the correct size. You will adjust this next.

23. To edit the image size: in the Appearance panel, click directly on the image swatch located above the image name (i.e., the link you clicked on to change the image).

FYI: Not the preview image at the top.

You are now in the Texture Editor dialog (Figure 4-3.11). Here you may adjust several settings related to the raster image.

At the moment, the edge dimensions are not equal, thus the image is being stretched. You will need to deactivate the “lock aspect ratio” feature so the two edge dimensions can be changed independently.

24. Click the chain icon pointed out in Figure 4-3.11.

Next you will adjust the Scale dimensions. Even though the project is set up for feet and inches, it is possible to enter metric values and Revit will automatically convert it. This is true anywhere you enter a length in Revit, other than the plain Text command. Interface happens to manufacture their carpet tile to a metric size so you will try this now.
25. Highlight the value listed next to *Width* and type: **50cm**.

26. Make the same change for *Height*.

27. Click **Done**.

28. Uncheck **Bump** on the *Appearance* panel.

The *Bump* mapping helps materials look more three-dimensional when rendered. However, the map is a grayscale image based on the main image file. This requires working on a copy of the image in another project such as Adobe Photoshop, which will not be done at this time.

29. Switch to the *Graphics* panel and check **Use Render Appearance** under *Shading*.

Notice how Revit automatically adjusts to the color to match the color of the raster image. This shading color is what is used for *Shaded* and *Consistent Colors* Display Styles.

You will leave the surface and cut patterns as they are for now. It should be pointed out that the image will not rotate as shown in the sample installation image on the website. To do this, one would have to use an image editing program to create the desired repeating pattern.

30. Using the steps just covered; create two more *Materials* for **CPT2** and **CPT3** as defined on page 4-23. Be sure to duplicate the *Appearance* asset each time.

**FYI:** When you duplicate **CPT1** you save some typing (i.e. data entry) as all the values for the selected Material are also duplicated. However, you need to be careful and review everything so you do not leave incorrect information assigned to the new Material.

The process just covered will usually be the same for any carpet manufacturer, or any product manufacturer in general. The only challenge is some websites are easier to navigate than others, and raster images may not always be available or of good quality (i.e., resolution and size).

Next you will take a look at creating several paint sample materials. This will involve locating the specific paint color’s RGB color rather than a raster image. The RGB color can then be entered for shaded views as well as for rendered views.
Each paint manufacturer organizes their color information a little differently. We will take a look at the Sherwin-Williams website specifically. Often, the other paint manufacturer’s sites will be similar. Be sure to check out the various color tools provided, such as the smartphone and Adobe Photoshop options. Below is the list of colors you will be working with:

<table>
<thead>
<tr>
<th>Part No.</th>
<th>Paint Type</th>
<th>Color Code</th>
<th>Color</th>
<th>Manufacturer</th>
<th>Model Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT1</td>
<td>Paint 1 (Walls)</td>
<td>R242 G226 B195</td>
<td>Beige</td>
<td>Sherwin-Williams</td>
<td>SW0051 Classic Ivory</td>
</tr>
<tr>
<td>PT2</td>
<td>Paint 2 (Interior HM Doors &amp; Frames / Steel)</td>
<td>R99 G101 B98</td>
<td>Gray</td>
<td>Sherwin-Williams</td>
<td>SW7068 Grizzle Gray</td>
</tr>
<tr>
<td>PT3</td>
<td>Paint 3 (Ceilings &amp; Soffits, Exposed Structure)</td>
<td>R233 G236 B232</td>
<td>White</td>
<td>Sherwin-Williams</td>
<td>SW7007 Ceiling Bright White</td>
</tr>
<tr>
<td>PT4</td>
<td>Paint 4 (Accent Wall Color)</td>
<td>R120 G107 B100</td>
<td>Brown</td>
<td>Sherwin-Williams</td>
<td>SW6040 Less Brown</td>
</tr>
<tr>
<td>PT5</td>
<td>Paint 5 (Toilet Rooms)</td>
<td>R203 G184 B162</td>
<td>Brown</td>
<td>Sherwin-Williams</td>
<td>SW6093 Familiar Beige</td>
</tr>
</tbody>
</table>


32. Choose your region.

33. Select USA → For Architects, Specifiers & Designers.

34. Click the Color Selection link.

Next you will search for the model number for the first paint type; PT1.

35. In the search box, type SW0051 and then press Enter.

36. Click on the preview swatch for Classic Ivory to see more information.

You should now see the information shown below (Figure 4-3.12). Notice the RGB Value listed: 242,226,195. This is the Red, Green and Blue colors which make up the Classic Ivory color. This information can be entered into the Revit material to create the proper color representation. Next you will create the PT1 Material in Revit.
The paint material is a little more complicated than carpet in that the Revit Material will also represent the building material being painted. In Revit, the paint finish is applied to the face of the concrete block (CMU) or gypsum board (GWB). Therefore, you have to create a PT1 paint Material for both CMU and for GWB. This is due to the fact that each material has a different cut and surface pattern. This might make more sense after the next few steps.

37. Back in your Law Office Revit model, open the Materials dialog(s).

38. Select the Material Gypsum Wall Board.

39. Duplicate the Material (via right-click).

40. Rename the new Material to Gypsum Wall Board – PT1.

41. Fill out the Identity panel using the information from the website as shown in Figure 4-3.13.
42. Switch to the Appearance panel.

Next you will need to replace the Appearance asset with one specifically meant for paint. Currently it is set to Generic and not Wall Paint as pointed out in Figure 4-3.14.

43. Hover your cursor over the Appearance asset name and then click the small icon which appears to the right (Figure 4-3.14).

The Asset Browser has now opened (Figure 4-3.15). Here you need to select a Wall Paint asset and overwrite the Generic asset in the law office model.

All the Wall Paint assets provided are for specific colors, so we essentially need to duplicate one and rename it. However, the assets in the Autodesk libraries are not editable. So we need to load one into the project and then rename it. We will do this next.

44. In the Appearance Library list on the left, select Wall Paint (Figure 4-3.15).

45. Click the “load into project” icon for the Beige asset, or double-click the asset name.

The appearance asset should now be updated in your project. Next you will rename it. This can be done in the Asset Browser.

46. In the Asset Browser, select Document Assets on the left (Figure 4-3.16).
47. Right-click on **Beige**

48. Select **Rename**.

49. Type: **SW 0051 Classic Ivory**

50. Close the **Asset Browser** by clicking the “X” in the upper right.

Now you can adjust the specific paint information for your **Material** (Figure 4-3.17). Keep in mind that this **Appearance** asset may be applied to other **Materials** in your project. For example, the asset could be applied to a CMU wall, or metal railing. Any adjustments made to the asset are instantly applied to all **Materials** which use it.

51. Click on the **RGB color numbers** to adjust them.

52. Change the RGB numbers as follows (Figure 4-3.18):
   a. R: 242
   b. G: 226
   c. B: 195

As you recall, the RGB value came from the paint manufacturer’s website. The color swatch in Revit should look very similar to that shown on the website. Keep in mind that individual monitors and color printers can vary significantly in how they represent a color. It is always best to get a physical color sample before making final selections. But this will get you close!

53. Adjust the **Finish** option to **Eggshell**.

54. Leave the **Application** option set to **Roller**.
Notice how the Appearance options available vary from one material type to another. This allows you to control the real-world characteristics more accurately for a number of types or materials. This is more convenient than having all possible options when they do not really apply.

55. Switch to the Graphics panel.

56. Make sure the Use render Appearance under Shading is checked (Figure 4-3.17).

Notice how the RGB color matches the value you entered for the render Appearance. Again, the Appearance information is for Realistic & Ray Trace mode and used when creating photorealistic renderings. The Shading information is used in plan, elevation and 3D views when the Visual Style is set to Shaded or Consistent colors.

Next you will set the cut pattern to None. It is not typically necessary to hatch this material (i.e. gypsum board) because it is not very thick (1/2” – 5/8” typically), so the pattern does not read well.

57. Set the Cut Pattern to None (Figure 4-3.19).

58. Repeating the steps just covered; create a material for PT2 through PT5 as shown on page 4-29.
   a. PT2 should be duplicated from Steel, Paint Finish, Ivory, Matte in AEC Materials library.
   b. PT3 should be duplicated from Gypsum Ceiling Board.

59. Remember to Save your project often to avoid losing work.

FIGURE 4-3.19 Material Editor; Graphics panel
Exercise 4-4:
Revit Materials Concepts Applied – Part 2

We will continue to develop several real-world materials in Revit Architecture.

09 30 00 - TILING

**CT1 CERAMIC TILE 1 (SHOWER WALL TILE)**
- **MFG:** DAL TILE
- **STYLE:** MATTE WALL TILE
- **SIZE:** 4-1/4” X 4-1/4” NOMINAL
- **COLOR:** X735 ALMOND

**CT2 CERAMIC TILE 2 (SHOWER CEILING TILE)**
- **MFG:** DAL TILE
- **STYLE:** SEMI-GLOSS WALL TILE
- **SIZE:** 4-1/4” X 4-1/4” NOMINAL
- **COLOR:** 0190 ARCTIC WHITE
- **PATTERN:** INSTALLED AT 45 DEGREES ON SHOWER CEILINGS
- **GROUT:** 44 BRIGHT WHITE

**PRT1 PORCELAIN TILE 1 (FLOOR TILE)**
- **MFG:** DAL-TILE
- **STYLE:** CITY VIEW
- **SIZE:** 18” X 18” NOMINAL
- **COLOR:** CY04 DOWNTOWN NITE
- **GROUT:** TEC 927 LIGHT PEWTER

**PRT2 PORCELAIN TILE 2 (WALL BASE TILE)**
- **MFG:** DAL-TILE
- **STYLE:** CITY VIEW
- **SIZE:** 6” X 12” NOMINAL COVE BASE
- **COLOR:** CY04 DOWNTOWN NITE
- **GROUT:** TEC 927 LIGHT PEWTER

The third material you will create is tile; both ceramic and porcelain. This is similar to the previous examples, except you will set up a surface pattern for the size tile to be used and also deal with entering a color when the RGB color is not directly available. The materials you will create are listed above.

1. Open the *Material Browser* dialog in Revit.

2. Sort by the *Category* column by clicking on the heading “Category” as shown in the image to the right.

You should see two materials; “Ceramic Tile – 4” Blue” and “Porcelain, Ivory”.

4-34
First you will create a ceramic tile Material called CT1. Similar to the floor finish you created for carpet, you will not worry about the floor construction. The floor finishes will be applied differently than how the wall finishes are applied. The main reason for this is to show two ways in which materials may be applied; however, it is possible to use only one or the other. We will discuss this more in the chapters dealing with modeling.

3. Select Ceramic Tile – 4” Blue and Duplicate it via right-click.

4. Rename the new Material to CT1.

5. With the new Material selected, switch to the Identity panel in the Material Editor.

Next you will go to the Dal Tile website and search for the specific tile under consideration. You will find on this specific website that each tile does not have its own page. Thus, the URL will have to either point to the main website or the page for the series of the selected tile.


7. In the search box enter X735.

8. Click on the View Matte Series link below the Matte tile preview.

9. Use the current web page address for the Material URL in Revit.

10. Find the X735 tile sample.

Notice there is not a lot of information about the tile here. You have to go elsewhere to find the size of the tile. Also, the RGB color is not given. One technique to derive the RGB color is to right-click on the image on the website, select Save Picture As and then save the preview image to a file on your computer’s hard drive. Next you could open this image in an image editing program such as Adobe Photoshop and use the Color Picker tool to list the RGB values of the image. You will be provided the RGB colors so you do not need to use another program at this time.

11. Finish entering the information on the Identity panel as shown in Figure 4-4.1.
Note that the *Type* being set to *Ceramic* in the *Identity* panel (Figure 4-4.1) only relates to which category the *Material* is listed under in the *Material Bowser*, and does not directly relate to the actual material assigned in the *Appearance* panel. However, you should make sure they match so there is no contradiction.

12. Switch to the **Graphics** panel.

13. Make sure **Use Render Appearance** under *Shading* is not checked.

14. Click the color swatch to adjust the RGB color.

15. Set the RGB color to:
   - R=231, G=220, B=202
   (similar to Figure 4-3.17).

16. Click the *Surface Pattern* preview, select the **Model** option, and then select *4.25'' Tile*.

17. Set the *Cut Pattern* for the tile to **None** (Figure 4-4.2); click the preview and then click the *No Pattern* button.

With these settings one could begin to design using the CT1 material. However, the *Appearance* panel does not have a proper image file selected to represent the selected tile. It is still set to the blue tile.

Because we do not have a representative image with a repeating grout pattern to download, you have to either find one in the *Autodesk Library*, modify a material, take a picture of the tile installed somewhere or find something online.

18. Switch to the **Appearance** Panel.

Notice this material is currently using an image file to represent the tile (Figure 4-4.3). This would be similar to taking a photo of an installed tile and then cropping it so that it repeats nicely. In the next few steps you will take a look at another option for representing tile.

19. Click the down-arrow to the right of the image preview (Figure 4-4.3).

20. Select **Tiles** from the list.
Revit still understands this material to be “ceramic” but rather than using an image, it is now using a “synthetic” tile pattern. The appearance asset is synthetic in that it is computer generated. As you will see in a moment, this provides the designer with the tools to quickly create a tile pattern when an image file is not available.

21. Click the **Edit**… link below the *Tiles* preview (Figure 4-4.4).

You are now in the *Texture Editor* shown in Figure 4-4.5. Here you can adjust all sorts of settings related to how the tile pattern should appear. One of the adjustments one can make is the tile pattern. Is the pattern stack bond, running bond, common flemish bond, etc. You can even adjust the ground color and size.

This method can be used for many other materials such as sidewalks. For sidewalks, the number of rows can be set to zero and the column set to be about 5'-0" or whatever spacing you want.

22. Make the adjustments shown in Figure 4-4.5.

23. Click **Done** to exit the Texture Editor.
The Material Editor dialog below shows one of the other options shown in Figure 4-4.3. This is the Checker option where you can select two separate colors. This can be used for an entire wall or in an accent area (Figure 4-4.6). Be sure to explore the other options, such as Wood, which can be used to represent wood or other things such as art glass.

**FIGURE 4-4.5** Texture editor

**FIGURE 4-4.6** Material editor (alternate option)
A Relief Pattern would be like embossing a piece of paper. In the raster image currently being used (TileSquareBump.png in this case) the non-white areas are embossed on the otherwise flat/infinite ceramic material. This Relief Pattern gives the general appearance of a tile pattern.

24. Switch the Relief Pattern to a Tile pattern, similar to steps 19 and 20.

25. Adjust the settings to match Figure 4-4.7.

Notice the other options, including the ability to rotate the pattern.

26. Click Done.

27. Switch back to the Graphics panel.

28. Click the Texture Alignment button.

This can be used to make sure the surface pattern and the appearance pattern align.

29. Click the arrows if necessary to make the fill pattern align with the render appearance pattern (Figure 4-4.8).

30. Click OK to close the Material Browser.

FIGURE 4-4.7 Texture Editor for relief pattern

FIGURE 4-4.8 Texture alignment
The following two images in Figure 4-4.9 highlight the difference in a rendered image when the Relief Pattern is used, as seen in the example on the left, and when one is not, on the right. The Relief Pattern actually gives the material a three-dimensional look. The lighting in the space is actually in sync with the Relief Patterns as well. Notice how the shade and highlights correspond with the lighting primarily coming from the top right in the image on the left. The image on the right is flat and void of any shading or highlights at the edge of the tiles.

![Figure 4-4.9 Rendered material with Relief Pattern on left, and without on right](image)

Now you will create another ceramic tile pattern using CT1 as a starting point.

31. Create Material CT2
   a. Duplicate CT1 via a right-click
   b. Rename to CT2 also via right-click

32. Switch to the Graphics panel.

33. Use the following RGB values for shading:
   R=244, G=240, B=237.

Next you will adjust the Surface Pattern so it is rotated 45 degrees.

34. On the Graphics panel, click the pattern preview next to Surface Pattern.

35. Set the Pattern Type to Model and then click the New button.

36. Adjust the settings to match Figure 4-4.10; enter the Name 4.25” Tile at 45 Degrees.

![Figure 4-4.10 Add Surface Pattern dialog](image)
37. Click **OK** to create the new model pattern. Remember, model patterns do not change scale with the view.

This new *Fill Pattern* is now available to any tool or feature which utilizes the fill patterns.

38. In the Fill Pattern dialog, click **OK** to accept the new pattern for the material’s *Surface Pattern*.

39. Switch to the *Appearance* panel.

Before making any changes to the *Appearance* asset you need to understand that the *Material* you just copied (i.e. CT1) is using the same asset. So if you rotate the *Appearance* asset for CT2, it will also change CT1. Also, the name of the *Appearance* asset is no longer appropriate for CT1 or CT2. In the next few steps you will rename the *Appearance* asset, and notice how both Materials are affected. Then you will duplicate the *Appearance* asset and assign the new one to CT2.

40. Click the **Open/Close Asset Browser** icon at the bottom of the *Material Editor*.

41. Select *Document Assets* in the upper left.

42. **Right-click** on *Ceramic Tile – 4” Blue* and select **Rename** (Figure 4-4.11).

43. Enter the name **CT1** and then press **Enter**.

44. Back in the *Material Browser*, switch between *Materials* CT1 and CT2 and notice they both have this newly renamed *Appearance* asset assigned to them.

   **TIP:** the *Asset Browser* can remain open while switching back to the *Material Browser* or *Material Editor*.
Next you will duplicate the Appearance asset CT1 and create a CT2 version.

45. In the Material Browser, select CT2.

46. In the Material Editor, right-click on CT1 (Figure 4-4.12).

47. Select Duplicate.

48. Now switch to the Asset Browser and rename the CT1(1) copy to CT2.

You now have a new Appearance asset called CT2 which can be applied to multiple Materials if needed. Changing it in one place changes it in all locations.

49. Adjust the rotation of Ceramic and Relief Pattern to 45 degrees (Figure 4-4.13).

50. Adjust the RGB color for the ceramic to R=244, G=240, B=237

51. Switch back to the Graphics panel.

52. In the Surface Pattern area, click the Texture Alignment button.

53. Notice that the Surface Pattern and the render texture, i.e., appearance, both align. Try clicking the arrows, but click Cancel to close without making changes.

54. Click OK to close the Material dialogs.

55. Save your project.

Your Material preview should look like that shown in Figure 4-4.14 to the right. Notice the Material name and the two assets, Graphics and Appearance, are all the same; CT2. It is not required that they all match, but can be helpful in most situations.
Next you will create the last two tile materials.

56. In the Materials dialog, select CT1 and then Duplicate it; name the new material PRT1.

57. Adjust the Identity information per the steps previously covered to create the ceramic materials; see page 4-35.

58. Switch to the Graphics panel.

59. Check Use Render Appearance for Shading.

60. Click the Surface Pattern preview area.

61. Set the Pattern Type to Model and then click New.

62. Create a new pattern named 18" Tile; adjust the settings to match Figure 4-4.15.

63. Click OK twice to get back to the Material Editor.

Next you will modify the Appearance panel. But first you might want to review the Texture Alignment to see how things do not currently align.

64. Switch to the Appearance panel.

You will notice from the manufacturer’s website that the selected porcelain tile is not a simple solid color. It has a natural irregular pattern to it. So you might not want to use the same appearance previously applied to CT1 and CT2. Next you will download an image from the manufacturer’s website.

65. Go to www.daltile.com and search for tile number CY04.

66. Select the small preview image to open a larger preview image (Figure 4-4.16).
67. **Right-click** on the large preview image and **select** **Save Picture As** (or **Save Image As**).

68. **Select** a location for the image file to be saved on your computer.

The only problem with this image is it does not have a grout joint around the perimeter. This will not look great in a rendering; due to the irregular pattern a line will still be apparent. It is possible to use an image editing program, such as Adobe Photoshop, to correct the problem. To add the joint, you would want half a joint so it tiles, or repeats, properly on a surface in the model. You will not be required to make these types of edits at this time.

69. **Duplicate** the **Appearance** asset, and rename the new copy to **PRT1** (similar to step 45).

   **TIP:** After **Duplicating** the asset via right-click, you can rename it in the **Material Editor** below, by expanding the **Information** section (see image to the right).

70. Back in the **Material Editor**, with **PRT1** selected, adjust the **Description** as shown in Figure 4-4.17.

Next you will change the **Appearance** asset to use an image rather than the “synthetic” **Tiles**.

71. **Select** the down-arrow to the right of the **Tiles** preview and select **Image** (Figure 4-4.17).

You now have a raster image file based **Appearance**. You will change it to the image you just downloaded.

72. **Browse** to the raster image of the CY04 tile you saved from the Daltile website.

73. **Click** on the image preview, in the **Material Editor**, to open the **Texture Editor**.

74. In the **Texture Editor**, change the **Sample Size** to 3'-0"x3'-0"; this is for two 18" tiles in each direction (Figure 4-4.18).
75. Click **Done** to close the *Texture Editor*.

Now you need to adjust the *Relief Pattern*. This will remain the “synthetic” Tiles option. You will adjust the spacing to align with the grout joints in the image. You will also make an adjustment so the joint does not look too deep.

76. Edit the **Relief Pattern** as follows:
   a. Set the *Sample Size* to 3'-0”
   b. Set the *Grout Color* to 
      \[ R = 125, \quad G = 125, \quad B = 125 \]

You need to note that the raster image and the relief pattern are both setup to show full tiles. If this were not the case you would need to offset the relief pattern to align with the image.

To better visualize the changes you are making, it is possible to adjust the preview image to be larger and to represent a wall.

77. Click the down-arrow next to the *Material Editor* and select **Walls** (Figure 4-4.19).

78. Adjust the preview size by dragging the width of the dialog box (to adjust the height) and the horizontal line just below the image (to adjust the height).

You now have a larger image which looks like a wall to better visualize your material. Notice how the grout joint does not appear to be as deep. In the *Relief Pattern*, the darker the graphics, the deeper the relief appears in those areas in the material. Therefore, when we make the grout lines a lighter grey, the appearance became less recessed.
Next you will duplicate PRT1 to create PRT2. Both are based on the same tile. One is for the floor and the other is meant to be used as wall base. The wall tile is 6”x12”. This can be set up as 12”x12” as the tile will be cropped by the surface it is applied to in the model. That is, PRT2 will only be used as a wall base and only applied to an area that is six inches tall.

79. Duplicate PRT1 as PRT2.

80. Adjust the Identify panel.
   a. **Comments**: PORCELAIN WALL BASE TILE
   b. **Mark**: PRT2  
      Remember to always set this value when duplicating a material
   c. Everything else is the same as PRT1.

81. On the Graphics panel, set the Surface Pattern to 12” Tile.

82. On the Appearance panel, duplicate the asset and then adjust the texture size to be 2’x2’; this is for two 12” Tiles.
   a. Do this for both the image and the relief pattern.

83. Close the Materials dialog; be sure to click the OK button and not the red “X” in the upper right as this will cancel and discard your changes.

84. Save your project file. You will use this model in subsequent chapters.

You should save all the image files you create or download into a single folder if possible. If working in an office, the folder should be on a network, accessible to everyone on the design team. In Revit, everyone can go to Application Menu → Options → Rendering and add “additional render appearance paths” so Revit knows where the images are locations and can access them when needed.

This wraps up a fairly thorough overview of using and managing Materials in Revit. You should hang on to this book so you can refer back to this information as needed. Eventually, you will know how to do these steps by memory as there are lots of materials on projects. Keep in mind that your favorite materials can be added to a custom template file or custom material library so they are available immediately for all your projects.
Exercise 4-5:  
Revit Materials and Custom Parameters

This last section will look at an intermediate concept related to Revit materials. Often there is additional information you might wish to keep track of for a given material. Revit allows you to create custom parameters which are able to hold additional information about the material. It is not essential that you know how to do this now, but it is easy so why not give it a try!

You may have noticed some of the websites you visited in this chapter list data like Post-Consumer Content. You may also want to keep track of the distance in miles to the main source of the material. These metrics are used to rate the sustainability of a building and factor in to programs such as Leadership in Environmental and Energy Design (LEED).

1. In Revit, switch to the **Manage** tab on the **Ribbon**.
2. Select **Project Parameters**.
3. Click **Add**.
4. Enter the information as shown in Figure 4-5.1 below.

![Parameter Properties](image)

**FIGURE 4-5.1 Creating a project parameter**

5. Click **OK** to create the parameter.
6. Add another project parameter called **Source (miles)** with all other settings the same as the previous steps.

7. Click **OK** and then click **OK** again to close the **Project Parameters** dialog.

8. Open the **Materials** dialog, open the **Material Editor** if not already open.

9. Click the **Custom Properties** button in the lower left (Figure 4-5.2).

Notice the custom parameters area associated with every **Material** – be sure the correct **Material** is selected before editing the **Custom Parameters**. You are able to add as many custom parameters as you need. This information can also appear in a schedule; you will learn more about schedules later in the book.

**FIGURE 4-5.2** Custom material parameters in the **Materials** dialog
Self-Exam:
The following questions can be used as a way to check your knowledge of this lesson. The answers can be found at the bottom of this page.

1. To control the extents of the Paint tool on a face, use the Split Face tool. (T/F)
2. A material cannot store information about the manufacturer. (T/F)
3. It is not possible to rotate a surface pattern. (T/F)
4. Not all render appearance materials tile properly. (T/F)
5. You can store custom information in a Revit material. (T/F)

Review Questions:
The following questions may be assigned by your instructor as a way to assess your knowledge of this section. Your instructor has the answers to the review questions.

1. To change a material “By Face” use the Paint tool. (T/F)
2. You can only duplicate materials, not start from scratch. (T/F)
3. A material’s surface pattern is what would be seen in an interior elevation. (T/F)
4. List three primary ways materials are added: by ________, by ________, by ________.
5. For a render appearance, a relief pattern would be like embossing a piece of paper. (T/F)
6. The glass material is transparent in 3D but not in elevation. (T/F)
7. The Identity panel, in the Materials dialog, has a section for shading adjustments. (T/F)
8. Revit does not come with any Materials. (T/F)
9. Model Fill Patterns adjust size when the view scale changes. (T/F)
10. When a 3D element has its material parameter set to <by category>, the ________ ________ material is used.

Self-Exam Answers:
1 – T, 2 – F, 3 – F, 4 – T, 5 – T